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Topic 1. Accessing Excel

For this course, the default option for accessing Excel will be through the desktop application. To
open Excel, click the Start button located in the taskbar in the bottom of your screen.

Figure 1: Taskbar

Figure 2: Start Menu

In the start menu that pops up, either select the
app in the red box, or search for Excel using the
search function in the blue boxto access the desk-
top version of Excel. You may also access an online
version of Excel fromMicrosoft 365, but we will be
sticking to the desktop version for this course.

Figure 3: Backstage View

With the Excel window opened, you can start a new workbook by clicking the red box in Figure 3.

Wewill try to stay away from the onlineMicrosoft 365 version of Excel for the duration of this couse.
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Topic 2. What are Spreadsheets

Spreadsheets are essentially collections of data organized into columns and rows. One can think of
columns as data stacked on top of each other, while rows represent data arranged side-by-side. The points
where columns and rows intersect are known as “cells,” which contain the data. A group of these data-
holding cells constitutes a spreadsheet.

Figure 4: Rows, Columns, and Cells

Columns are labeled using a range of 16,384 letters, and rows are numbered up to 1,048,576. As a
result, a single Excel sheet contains a total of 17,179,869,184 cells. The convention for referencing cells is
to mention the column followed by the row (e.g., W18). You needn’t memorize the exact numbers, but
it’s important to recognize that there are limitations to the dimensions of data that Excel can handle.

• Coumns: A, B,⋯, Z, AA, AB,⋯, ZZ, AAA, AAB,⋯, XFD

• Rows: 1, 2,⋯, 1048576

• Cells: A1, A2,⋯, XFD1048576

Topic 3. Entering and Editing Data in Excel

Each cell in Excel can have an entry that is either text, numbers, or formulae. To add information
to an empty cell in Excel, you can simply select the cell you wish to store information, and type in the
desired information. Once you are finished typing in the desired information, simply press the enter
key on your keyboard. In order to overwrite information in any cell, select said cell, and typing in the new
information that you want, pressing enter will automatically overwrite the pre-existing information in
said cell.
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Figure 5: Editing Information in Cells

In order to edit some parts of pre-existing information in a cell, you may first select the cell that con-
tains the information youwant to change, and either (a) double-click the cell, (b) press f2 to enter editing
mode, or (c) directly edit information in the formula bar in the red box in Figure 5.

Topic 4. Row Heights and ColumnWidths

Row Height

Please take some time to compare the two tables below, and consider which is more “readable”. The
figure to the left is set to the default row height of 14.4, and to its right is the same table with the row
height adjusted to 18.2.

Figure 6: RowHeight = 14.4 Figure 7: RowHeight = 18.2

While there isn’t a definitive consensus on the ideal row height for a given document, a useful rule
of thumb is to aim for around 1.5∼1.7 times your font size. For instance, with a font size of 12, a suitable
range for your row height would be between 18 and 20.4. Nevertheless, this guideline heavily relies on
factors such as the document’s purpose, target audience, and whether it’s intended for paper printing,
among other considerations.
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Adjusting the Height of a Row

To adjust the height of a single row, start by left-clicking on the rownumber that youwant tomodify.
Next, right-click on the same row number to bring up a menu, as illustrated in Figure 8.

Figure 8: Adjusting the height of row 3

Adjusting the Height of Multiple Rows

To modify the row height for multiple rows, follow these steps: left-click on the first row you want
to include, hold down the Shift key, and then left-click on the last row you want to adjust. After that,
release the Shift key. Next, right-click on any of the selected row numbers and proceed with the same
steps as you would when changing the height of a single row.

Figure 9: Adjusting the height of rows 3 to 20
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Adjusting the Height of All Rows

In Excel, left-clicking on the top left-hand corner, as shown in Figure 10, will select all cells in the
sheet. Once you have selected all cells, you can adjust the height of all rows by right-clicking on any of the
row numbers and then following the same steps as you would for changing the height of a single row.

Figure 10: Selecting all cells

Width of Columns?

Similar to adjusting rowheights, thewidth of each columnmay need to bemodified to accommodate
the length of the information stored in specific cells. As with rows, there is no definitive rule to follow
when determining the width of a column. Feel free to experiment with different widths, but ensure that
all the information in the column remains easily visible.

Figure 11: Adjusting the width of column E
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Automatic Adjustments

If you’re uncertain about the appropriate width or height for specific columns or rows, there’s a way
to let Excel make the selection for you. If you encounter a column (or row) that is too narrow (or short)
to display all of its content, you can hover your mouse over the “end” of the column (or the “bottom” of
the row) as shown in Figure 12. The mouse cursor should change its shape, and when you double-click,
Excel will examine all the elements in the column (or row) and adjust the width (or height) to neatly fit
all the content.

Figure 12: Narrow columns Figure 13: Column width adjusted

Topic 5. Fonts, Alignments, Colors

Font and Font Size

There are various formatting optionswhen it comes to text in cells. The first topic wewill be covering
is a review of the font and font size. Recall that the font and font size can be edited accessing the Home tab
of the ribbon. You may change the font by either selecting or typing in your desired font in the red box
in Figure14. The font size can be changed similarly by using the blue box. A quick alternative to selecting
the font size using the blue box would be to use the options given in the orange box to enlarge or shrink
the font size of the selected cell(s).

Figure 14: Font and Font Size
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Alignment

Users may also change the alignment of the content in a given cell both vertically and horizontally.
The contents’ vertical alignmentwithin the cell can be changed using the options in the red box of Figure
15. The left aligns contents to the top of the cell, the middle aligns contents to the middle, and the right
aligns items to the bottom of each cell. Using the options in the blue box, we can align the content
horizontally within the selected cell(s). The two options in the orange box can decrease and increase how
much the content is indented in each cell(s). Finally, the green box is an option that can be used to angle
the text in various directions.

Figure 15: Alignment Options

Colors

Excel allows users to change the color of the content in cells by using the font color options located in
the Home tab, highlighted by a red box in Figure 16. The background color of cells can also be changed
using the option highlighted by the blue box. Selecting the ⋁ on either of the two options will open up
the option window shown to the right of Figure 16 where users can choose their color of choice.

Figure 16: Font and Cell Color Options
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Multiple Lines in a Single Cell

Sometimes users may have certain cells that contain a large amount of text so that it does not nicely
fit in one cell. While one may expand the cell width to ensure all content is displayed, this unneccessarily
limits the amount of information visible in one sheet by taking up space. One way to work around this
issue is to have line breakswithin a given cell. In these scenarios users canmake use of thewrap text option
found in the region highlighted by the red box in Figure 17. An alternate method would be to manually
break lines using alt+enter while editing the content of a given cell.

Figure 17: Wrap Text Option

Formatting Contents in Cells

We briefly covered the topic of formats and how it influences the cells’ contents. Recall that we can
change the content format of the cell by using the dropdown list highlighted in the red box in Figure
18. The blue box is a collection of shortcuts (left to right) to some commonly used formats, being cur-
rency(accounting), percentage, and adding commas for each 103. Finally the buttons in the orange box
can be used to add and remove decimal points.

Figure 18: Content Formatting
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Merge Cells

The merge cell command can be used to merge multiple cells into one larger cell. This function is
typically used to create titles, subtitles, added notes to the bottom of a table, etc. To use this command,
users first select the cells that they wish tomerge into one, and then click on themerge and center button
highlighted by the red box in Figure 19. Accessing the dropdown menu by clicking the ⋁, users can
choose different options when it comes to merging cells.

Figure 19: Merging Cells

Merge Alternatives

Merging cells can cause issues when we need to reference cells, copy and pasting, or hiding cells from
view. A neat alternative is to use the “center across selection” alignment option. Users should first select
the region where the text should be centered in, right click on the selected region, and select the Format
Cells option, and select “Center Across Selection.”

Figure 20: Alternative to Merge and Center
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Borders

Boders in the context of Excel refer to any lines that users may place in or around cells. By default,
Excel does not print the borders of each cell, instead has light gray gridlines that do not show up when
printing the material.1 In order to add borders to your worksheet, first select the range where you are
seeking to add borders. Then, navigate to the borders button in the Home tab highlighted by the red box
in Figure 21, and click on the dropdown button ⋁ to see the available options.

Figure 21: Borders Button Location

Figure 22: Border Dropdown

Figure 22 shows us the available preset optionswhen it comes to
the borders. While it is perfectly fine to apply any of these options,
we are primarily interested in the last option, “More Borders...” Se-
lecting this optionwill bring us to Figure 23. Here we canmanually
tell Excel which borders we want to add, the colors they should be,
and the patterns and thickness, etc.

Figure 23: Border Options
1Setting the cells’ background color to be white will hide the gridlines from those cells.

10



Topic 6. Worksheets

Adding NewWorksheets

A single Excel work‘book’ can have multiple work‘sheets’. To add another worksheet to your current
workbook, simply click on the + sign on the bottom of the window. It is highlighted by a red box in
Figure 24.

Figure 24: Adding NewWorksheets

Renaming Worksheets

By default, each sheet will be named Sheet# where # increases from 1,⋯. Since this naming scheme
does not reflect the information contained in each worksheet, Excel allows users to rename each work-
sheet. To change the name of theworksheet, right click theworksheet’s tab on the bottomof thewindow,
and select rename in the red box. You may also double-click the name of the worksheet to rename the
worksheet.

Figure 25: RenamingWorksheets

Navigating Between Worksheets

The easiest way of navigating between worksheets is to left click the worksheet tab on the bottom
of the window. You can also navigate between adjacent worksheets using the hotkeys ctrl+pageup to
move to the previous sheet or ctrl+pagedown to move to the next sheet. Holding down the hotkeys
will take you to the first and last worksheets, respectively.

11



The Activate Worksheet Window

However, in a real-world scenario, the list of worksheets could be much longer and more detailed,
with dozens of sheets spanning several years. If worksheet names are sufficiently long, locating and click-
ing on the desired worksheet might become challenging. What can be done in such situations? Themost
“powerful” method for navigating between worksheets is to use the Activate option. Right-clicking
the boxed region shown in Figure 26 will bring up the Activate window, which displays the complete
list of worksheets included in the workbook.

Figure 26: Using the activate window

Worksheet Tabs

Figure 27: Sheet Tab Options

We change the background color of
each worksheet’s tab by right clicking on
the worksheet’s tab, and choosing a tab
color from themenu. Sometimes it is use-
ful to have worksheets that have a com-
mon themebe of a certain color towork as
amental shortcut. Youmay group tabs by
time, by function, or by importance, etc.
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Topic 7. Saving Workbooks

To save your workbook, navigate to the File tab on the top ribbon as shown in Figure ??.

Figure 28: RenamingWorksheets

Then, select Save As, the Browse, and then the directory you wish to save the workbook. In this
example, we choose Documents. Feel free to choose any other directory if it is more convenient for you.
Finally, you should name the file by typing in the desired file name in the green box. Once you are done,
select Save, and your workbook will be saved as the filename you typed in, at the directory you selected.

Figure 29: RenamingWorksheets

13


